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What readers are saying about Hello, Android

This is a most excellent book: very well written, easy to read, and fun.

In addition, any of Android’s quirks are explained along with just the

right amount of detail to ensure quality programming principles are

followed.

Anthony Stevens

Founder and CTO, PocketJourney and Top 20 Winner of

Google Android Competition

Ed Burnette covers an impressive amount of ground in a nicely com-

pact book while retaining the popular Pragmatic style. For the mate-

rial on 2D and 3D graphics alone, this is worthy of a spot in any

Android developer’s library.

Mark Murphy

Founder, CommonsWare

I remember when I �rst started to work with Android; it was like a

huge maze. With this book, the introduction would have been much

less painful. I am convinced that by reading this book new Android

programmers will have an easier start.

Gabor Paller

Senior Software Architect, OnRelay, Ltd.
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Changes (Cupcake Updates)
Android 1.5, also known as Cupcake, was released this spring. Cup-

cake contains a number of user- and programmer-facing changes that

broke examples in this book, and rendered some sections obsolete. This

series of updates will address these changes, and add new sections and

appendixes based on the Cupcake release.

All changes since the original printing will be �agged with an orange

color, like this text.

P1.1�May 26

This update contains the following changes:

� Chapter , Changes (Cupcake Updates): New section (you’re reading

it now) that will detail the changes made in each release.

� Chapter , Preface, on page 12: Updated for Cupcake.

� Chapter 1, Quick Start, on page 18: Updated for Cupcake. Added

new material on Android Virtual Devices (AVDs). Took new screen-

shots with 1.5_r1 and ADT 0.9.1v200905011822-1621.

� Appendix B, on page 221: New appendix on writing widgets (just

a placeholder for now).

� Appendix C, on page 222: New appendix on signing and publishing

(just a placeholder for now).

� Updated all sample source code �les1 so they build and run with

1.5. I haven’t updated the text that describes the samples.

� Tested all samples on 1.5 �rmware on a real phone except for

MyMap.

1. http://www.pragprog.com/titles/eband/source_code
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P1.1�MAY 26 11

� Various: Cleared up all outstanding errata.2

� Various: Fixed URLs that Google broke since the �rst printing.

TODO in future releases:

� Review the remaining chapters and make changes as needed.

� Double-check that sample code changes are re�ected in the text

that surrounds them.

� Update the MyMap sample to use new zoom API.

� Update the OpenGL sample to use new API.

� Write the Widget appendix.

� Write the Market appendix.

� Investigate what lead to user confusion in errata #38018.

Please give us your feedback on the new and updated material by post-

ing in the forum3 or by submitting errata.

2. http://www.pragprog.com/titles/eband/errata

3. http://forums.pragprog.com/forums/67
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Preface
Android is a new open source software toolkit for mobile phones that

was created by Google and the Open Handset Alliance. In a few years,

it’s expected to be found in millions of cell phones and other mobile

devices, making Android a major platform for application developers.

Whether you’re a hobbyist or a professional programmer, whether you

are doing it for fun or for pro�t, it’s time to learn more about developing

for Android. This book will help you get started.

What Makes Android Special?

There are already many mobile platforms on the market today, includ-

ing Symbian, iPhone, Windows Mobile, BlackBerry, Java Mobile Edi-

tion, Linux Mobile (LiMo), and more. When I tell people about Android,

their �rst question is often, Why do we need another mobile standard?

Where’s the �wow�?

Although some of its features have appeared before, Android is the �rst

environment that combines the following:

� A truly open, free development platform based on Linux and open

source: Handset makers like it because they can use and cus-

tomize the platform without paying a royalty. Developers like it

because they know that the platform �has legs� and is not locked

into any one vendor that may go under or be acquired.

� A component-based architecture inspired by Internet mashups:

Parts of one application can be used in another in ways not orig-

inally envisioned by the developer. You can even replace built-in

components with your own improved versions. This will unleash a

new round of creativity in the mobile space.

� Tons of built-in services out of the box: Location-based services use

GPS or cell tower triangulation to let you customize the user expe-

rience depending on where you are. A full-powered SQL database
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WHO SHOULD READ THIS BOOK? 13

lets you harness the power of local storage for occasionally con-

nected computing and synchronization. Browser and map views

can be embedded directly in your applications. All these built-in

capabilities help raise the bar on functionality while lowering your

development costs.

� Automatic management of the application life cycle: Programs are

isolated from each other by multiple layers of security, which will

provide a level of system stability not seen before in smart phones.

The end user will no longer have to worry about what applications

are active or close some programs so that others can run. Android

is optimized for low-power, low-memory devices in a fundamental

way that no previous platform has attempted.

� High-quality graphics and sound: Smooth, antialiased 2D vector

graphics and animation inspired by Flash are melded with 3D

accelerated OpenGL graphics to enable new kinds of games and

business applications. Codecs for the most common industry-

standard audio and video formats are built right in, including

H.264 (AVC), MP3, and AAC.

� Portability across a wide range of current and future hardware:

All your programs are written in Java and executed by Android’s

Dalvik virtual machine, so your code will be portable across

ARM, x86, and other architectures. Support for a variety of input

methods is included such as keyboard, touch, and trackball.

User interfaces can be customized for any screen resolution and

orientation.

Android offers a fresh take on the way mobile applications interact with

users, along with the technical underpinnings to make it possible. But

the best part of Android is the software that you are going to write for

it. This book will help you get off to a great start.

Who Should Read This Book?

The only requirement is a basic understanding of programming in Java

or a similar object-oriented language (C# will do in a pinch). You don’t

need any prior experience developing software for mobile devices. In

fact, if you do, it’s probably best if you try to forget that experience.

Android is so different that it’s good to start with an open mind.
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WHAT’S IN THIS BOOK? 14

What’s in This Book?

Hello, Android is divided into three parts. Roughly speaking, the book

progresses from less advanced to more advanced topics, or from more

common to less common aspects of Android.

Several chapters share a common example: an Android Sudoku game.

By gradually adding features to the game, you’ll learn about many

aspects of Android programming including user interfaces, multime-

dia, and the Android life cycle.

In Part I, we’ll start with an introduction to Android. This is where you’ll

learn how to install the Android emulator and how to use an integrated

development environment (IDE) to write your �rst program. Then we’ll

introduce a few key concepts like the Android life cycle. Programming

in Android is a little different from what you’re probably used to, so

make sure you get these concepts before moving on.

Part II talks about Android’s user interface, two-dimensional graphics,

multimedia components, and simple data access. These features will be

used in most programs you write.

Part III digs deeper into the Android platform. Here you’ll learn about

connecting to the outside world, location-based services, the built-in

SQLite database, and three-dimensional graphics.

At the end of the book, you’ll �nd appendixes that cover the differences

between Android and Java Standard Edition (SE), how to create a wid-

get, and publishing your application.

What’s New for Cupcake?

Android 1.5 (Cupcake) introduced a number of enhancements to the

Android platform including support for soft (on-screen) keyboards, video

recording, and application widgets. Under the covers, there were over

1,000 changes to the Android API between 1.1 and 1.5.4

To accommodate the new version, every page and example in this book

has been reviewed and updated so it will work with 1.5. Most of the

changes were small but a few sections needed major revisions. If you’ve

read this book before then be sure to check out these updated chapters:

4. http://developer.android.com/sdk/1.5_r1/upgrading.html
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ONLINE RESOURCES 15

� Chapter 1, Quick Start, on page 18 includes instructions on using

target SDKs and Android Virtual Devices (AVDs).

� Chapter 8, Locating and Sensing, on page 156 now uses the new

SensorManager APIs.

� Chapter 10, 3D Graphics in OpenGL, on page 193 has been greatly

simpli�ed thanks to the new GLSurfaceView class.

In addition, by popular demand we’ve added two new appendices:

� Appendix B, on page 221 shows you how to create a Widget for the

home screen. This is a new feature of Cupcake.

� Appendix C, on page 222 guides you through the steps of mak-

ing your application available for sale or for free on the Android

Market.

By the time you read this, Android 1.5 (or later) will be available for

all shipping Android devices. All new devices will have it installed, and

Google expects existing Android users to quickly upgrade. Therefore

this printing of the book will not cover version 1.1 or earlier.

Online Resources

At the website for this book, http://pragprog.com/titles/eband, you’ll �nd

the following:

� The full source code for all the sample programs used in this book

� An errata page, listing any mistakes in the current edition (let’s

hope that will be empty!)

� A discussion forum where you can communicate directly with the

author and other Android developers (let’s hope that will be full!)

You are free to use the source code in your own applications as you see

�t. Note: If you’re reading the PDF version of this book, you can also

click the little gray rectangle before the code listings to download that

source �le directly.

Fast-Forward >>

Although most authors expect you to read every word in their books, I

know you’re not going to do that. You want to read just enough to let

you get something done, and then maybe you’ll come back later and
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FAST -FORWARD >> 16

read something else to let you get another piece done. So, I’ve tried to

provide you with a little help so you won’t get lost.

Each chapter in this book ends with a �Fast-Forward >> section.� These

sections will provide some guidance for where you should go next when

you need to read the book out of order. You’ll also �nd pointers to other

resources such as books and online documentation here in case you

want to learn more about the subject.

So, what are you waiting for? The next chapter�Chapter 1, Quick Start,

on page 18�drops you right into the deep end with your �rst Android

program. Chapter 2, Key Concepts, on page 28 takes a step back and

introduces you to the basic concepts and philosophy of Android, and

Chapter 3, Designing the User Interface, on page 42 digs into the user

interface, which will be the most important part of most Android

programs.
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Part I

Introducing Android
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Chapter 1

Quick Start
Android combines the ubiquity of cell phones, the excitement of open

source software, and the corporate backing of Google and other Open

Handset Alliance members like Intel, TI, T-Mobile, and NTT DoCoMo.

The result is a mobile platform you can’t afford not to learn.

Luckily, getting started developing with Android is easy. You don’t even

need access to an Android phone�just a computer where you can

install the Android SDK and phone emulator.

In this chapter, I’ll show you how to get all the development tools

installed, and then we’ll jump right in and create a working applica-

tion: Android’s version of �Hello, World.�

1.1 Installing the Tools

The Android software development kit (SDK) works on Windows, Linux,

and Mac OS X. The applications you create, of course, can be deployed

on any Android devices.

Before you start coding, you need to install Java, an IDE, and the

Android SDK.

Java 5.0+

First you need a copy of Java. All the Android development tools require

it, and programs you write will be using the Java language. JDK 5 or 6

is required.

It’s not enough to just have a runtime environment (JRE); you need

the full development kit. I recommend getting the latest Sun JDK 6.0
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INSTALLING THE TOOLS 19

update from the Sun download site.1 Mac OS X users should get the

latest version of Mac OS X and the JDK from the Apple website.

To verify you have the right version, run this command from your shell

window. Here’s what I get when I run it:

C:\> java -version

java version "1.6.0_13"

Java(TM) SE Runtime Environment (build 1.6.0_13-b03)

Java HotSpot(TM) Client VM (build 11.3-b02, mixed mode, sharing)

You should see something similar, with version �1.6.something� or later.

Eclipse

Next, you should install a Java development environment if you don’t

have one already. I recommend Eclipse, because it’s free and because

it’s used and supported by the Google developers who created Android.

If you don’t want to use Eclipse (there’s always one in every crowd),

support for other IDEs such as NetBeans and JetBrains IDEA is avail-

able from their respective communities. Or if you’re really old-school,

you can forgo an IDE entirely and just use the command-line tools.2

The minimum version of Eclipse is 3.3.1, but you should always use

whatever is the most up-to-date production version. Note that you need

more than just the standard Eclipse SDK �classic� platform. Go to the

Eclipse downloads page,3 and pick �Eclipse IDE for Java Developers.�

Follow the directions there for downloading, unpacking, and installing

Eclipse into a suitable location (like C:\Eclipse on Windows).

Android

Next, download the latest Android SDK from Google. The Android down-

load page4 has packages for Windows, Mac OS X, and Linux. After

downloading the package that’s right for you, unpack the .zip �le to

a convenient directory (for example, C:\Google).

By default, the SDK will be expanded into a subdirectory like android-

sdk-windows-1.5_r1. This is your SDK install directory; make a note of the

full path so you can refer to it later.

1. http://java.sun.com/javase/downloads

2. See http://d.android.com/guide/developing/tools/index.html for documentation on the

command-line tools.
3. http://www.eclipse.org/downloads

4. http://d.android.com/sdk
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INSTALLING THE TOOLS 20

Figure 1.1: Installing the Android Development Toolkit

No special install program is needed but I do recommend you add the

SDK’s bin directory to your PATH. The next step is to start Eclipse and

con�gure it.

Eclipse Plug-In

To make development easier, Google has written a plug-in for Eclipse

called the Android Development Toolkit (ADT). To install the plug-in,

follow these steps (note these directions are for Eclipse 3.4�different

versions may have slightly different menus and options):

1. Start Eclipse, and select Help > Software Updates....

2. Click the Available Software tab if it’s not already selected.

3. Click the Add Site... button.

4. Enter the location of the Android update site: https://dl-ssl.google.

com/android/eclipse/. If you have trouble with this address, try

using http in the location instead of https.

Once you’ve �lled it out, the dialog box should look like Figure 1.1.

Click OK.

5. The Android site should now appear in the Available Software

view. Select the checkbox next to it, and then click Install.... If

you get an error message, then you may not have the right version

of Eclipse. I strongly recommend using either the prebuilt Eclipse

IDE for Java or the Eclipse IDE for Java EE Development pack-

ages, version 3.4 or newer.

Report erratum

this copy is (P1.1 printing, May 26, 2008)
Prepared exclusively for Antonio Pardo

https://dl-ssl.google.com/android/eclipse/
https://dl-ssl.google.com/android/eclipse/
http://books.pragprog.com/titles/eband/errata/add?pdf_page=20


INSTALLING THE TOOLS 21

Joe Asks. . .

It Says �Connection Error,� So Now What?

If you get a connection error, the most likely cause is some kind
of �rewall erected by your system administrators. To get outside
the �rewall, you’ll need to con�gure Eclipse with the address
of your proxy server. This is the same proxy server you use for
your web browser, but unfortunately Eclipse isn’t smart enough
to pick up the setting from there.

To tell Eclipse about the proxy, select Preferences > Network
Connections, turn on the option for Manual proxy con�gura-
tion, enter the server name and port number, and click OK. If
you don’t see the option, you may be running an older ver-
sion of Eclipse. Try looking under Preferences > Install/Update,
or search the preferences for the word proxy.

If you have a custom install of Eclipse, then to use the Android

editors you will also need to install the Web Standard Tools (WST)

plug-in and all its prerequisites.

See the Web Tools platform home page5 for more details and down-

load links. These are already built into the recommended packages

mentioned earlier.

6. Click Next, accept the license agreements, and then click Finish

to start the download and install process.

7. Once the install is done, restart Eclipse.

8. When Eclipse comes back up, you may see a few error messages

because you need to tell it where the Android SDK is located.

Select Window > Preferences > Android (Eclipse > Preferences on

Mac OS X), and enter the SDK install directory you noted earlier.

Click OK.

Whew! Luckily, you have to do that only once (or at least once every

time a new version of ADT or Eclipse comes out). Now that everything

is installed, it’s time to write your �rst program.

5. http://www.eclipse.org/webtools
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1.2 Creating Your First Program

ADT comes with a built-in example program, or template, that we’re

going to use to create a simple �Hello, Android� program in just a few

seconds. Get your stopwatch ready. Ready? Set? Go!

Select File > New > Project... to open the New Project dialog box. Then

select Android > Android Project, and click Next.

Enter the following information:

Project name: HelloAndroid

Build Target: Android 1.5

Application name: Hello, Android

Package name: org.example.hello

Activity name: Hello

When you’re done, it should look something like Figure 1.2, on the

following page.

Click Finish. The Android plug-in will create the project and �ll it in

with some default �les. Eclipse will build it and package it up so it will

be ready to execute. If you get an error about missing source folders,

select Project > Clean to �x it.

OK, that takes care of writing the program; now all that’s left is to try

running it. First we’ll run it under the Android Emulator.

1.3 Running on the Emulator

To run your Android program, go to the Package Explorer window,

right-click the HelloAndroid project, and select Run As > Android Appli-

cation. If you’re following along in Eclipse you may see an error dialog

like the one in Figure 1.3, on page 24. This indicates we haven’t told

the Emulator what kind of phone to emulate.

Creating an AVD

To do this, you need to create an Android Virtual Device (AVD), using

either Eclipse or the android avd command.6 It’s easier to use Eclipse,

so select Yes in the AVD Error dialog to open the AVD Manager. You

can open the manager again later by selecting Window > Android AVD

Manager.

In the AVD Manager dialog, �ll out the �elds for the new AVD as follows:

6. http://d.android.com/guide/developing/tools/avd.html
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Figure 1.2: New Android project

Report erratum

this copy is (P1.1 printing, May 26, 2008)
Prepared exclusively for Antonio Pardo

http://books.pragprog.com/titles/eband/errata/add?pdf_page=23


RUNNING ON THE EMULATOR 24

Keeping Up with the Plug-In

The Android Eclipse plug-in is a work in progress that changes
much more often than the Android SDK. The version you down-
load may be different than the one I used when writing this
book, and it may contain a few, shall we say, idiosyncrasies. I
recommend you check the plug-in site monthly to pick up any
new features and �xes.

Figure 1.3: Missing Android Virtual Device (AVD)

Name: em15

Target: Android 1.5 - 1.5

SDCard: 128M

Skin: Default (HVGA)

This tells Eclipse to set up a generic device called �em15� which has

the Android 1.5 (Cupcake) �rmware installed. A 128MB virtual Secure

Digital (SD) Card will be allocated, along with a half-VGA (320x480)

display.

When you’re done you should see something like Figure 1.4, on the

following page. Due to updates in the plug-in since this was written

your screen may look slightly different.

Click on Create AVD (not Finish) to create the virtual device. A few sec-

onds later you should see a message that the device has been created.

Click OK, and then you can click Finish.

Let’s Try That Again
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Figure 1.4: Creating an AVD in Eclipse

Once you have a valid AVD, the Android emulator window will start

up and boot the Android operating system. The �rst time you do this,

it may take a minute or two, so be patient. If you see an error mes-

sage saying that the application is not responding, select the option to

continue waiting.

After the emulator window starts, Eclipse will send it a copy of your

program to execute. The application screen comes up, and your �Hello,

Android� program is now running (see Figure 1.5, on the next page).

That’s it! Congratulations on your �rst Android program.
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Figure 1.5: Running the �Hello, Android� program

Shortening the Turnaround

Starting the emulator is expensive. Think about it this way�
when you �rst turn on your phone, it needs to boot up just like
any computer system. Closing the emulator is just like turning off
the phone or pulling the batteries out. So, don’t turn it off!

Leave the emulator window running as long as Eclipse is run-
ning. The next time you start an Android program, Eclipse will
notice the emulator is already there and will just send it the new
program to run.
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1.4 Running on a Real Phone

Running an Android program on a physical device such as the T-Mobile

G1 during development is almost identical to running it on the emula-

tor. All you need to do is connect your phone to the computer with a

USB cable and install a special device driver.7 Close the emulator win-

dow if it’s already open. As long as the phone is plugged in, applications

will be loaded and run there instead.

When you’re ready to publish your application for others to use, there

are a few more steps you’ll need to take. Appendix C, on page 222 will

cover that in more detail.

1.5 Fast-Forward >>

Thanks to the Eclipse plug-in, creating a skeletal Android program

takes only a few seconds. In Chapter 3, Designing the User Interface, on

page 42, we’ll begin to �esh out that skeleton with a real application�a

Sudoku game. This sample will be used in several chapters to demon-

strate Android’s API.

But before delving into that, you should take a few minutes to read

Chapter 2, Key Concepts, on the following page. Once you grasp the

basic concepts such as activities and life cycles, the rest will be much

easier to understand.

Although the use of Eclipse to develop Android programs is optional,

I highly recommend it. If you’ve never used Eclipse before, you may

want to invest in a quick reference such as the Eclipse IDE Pocket

Guide [Bur05].

7. You can �nd the device driver and installation instructions at

http://d.android.com/guide/developing/device.html.
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Chapter 2

Key Concepts
Now that you have an idea of what Android is, let’s take a look at how it

works. Some parts of Android may be familiar, such as the Linux ker-

nel, OpenGL, and the SQL database. Others will be completely foreign,

such as Android’s idea of the application life cycle.

You’ll need a good understanding of these key concepts in order to write

well-behaved Android applications, so if you read only one chapter in

this book, read this one.

2.1 The Big Picture

Let’s start by taking a look at the overall system architecture�the key

layers and components that make up the Android open source software

stack. In Figure 2.1, on the next page, you can see the �20,000-foot�

view of Android. Study it closely�there will be a test tomorrow.

Each layer uses the services provided by the layers below it. Starting

from the bottom, the following sections highlight the layers provided by

Android.

Linux Kernel

Android is built on top of a solid and proven foundation: the Linux

kernel. Created by Linus Torvalds in 1991 while he was a student at

the University of Helsinki, Linux can be found today in everything from

wristwatches to supercomputers. Linux provides the hardware abstrac-

tion layer for Android, allowing Android to be ported to a wide variety

of platforms in the future.
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Figure 2.1: Android system architecture

Internally, Android uses Linux for its memory management, process

management, networking, and other operating system services. The

Android phone user will never see Linux and your programs will not

make Linux calls directly. As a developer, though, you’ll need to be

aware it’s there.

Some utilities you need during development interact with Linux. For

example, the adb shell command1 will open a Linux shell in which you

can enter other commands to run on the device. From there you can

examine the Linux �le system, view active processes, and so forth.

Native Libraries

The next layer above the kernel contains the Android native libraries.

These shared libraries are all written in C or C++, compiled for the

particular hardware architecture used by the phone, and preinstalled

by the phone vendor.

1. http://d.android.com/guide/developing/tools/adb.html
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Some of the most important native libraries include the following:

� Surface Manager: Android uses a compositing window manager

similar to Vista or Compiz, but it’s much simpler. Instead of draw-

ing directly to the screen buffer, your drawing commands go into

offscreen bitmaps that are then combined with other bitmaps to

form the display the user sees. This lets the system create all

sorts of interesting effects such as see-through windows and fancy

transitions.

� 2D and 3D graphics: Two- and three-dimensional elements can be

combined in a single user interface with Android. The library will

use 3D hardware if the device has it or a fast software renderer if

it doesn’t. See Chapter 4, Exploring 2D Graphics, on page 71 and

Chapter 10, 3D Graphics in OpenGL, on page 193.

� Media codecs: Android can play video and record and play back

audio in a variety of formats including AAC, AVC (H.264), H.263,

MP3, and MPEG-4. See Chapter 5, Multimedia, on page 102 for an

example.

� SQL database: Android includes the lightweight SQLite database

engine,2 the same database used in Firefox and the Apple iPhone.

You can use this for persistent storage in your application. See

Chapter 9, Putting SQL to Work, on page 173 for an example.

� Browser engine: For the fast display of HTML content, Android

uses the WebKit library.3 This is the same engine used in the

Google Chrome browser, Apple’s Safari browser, the Apple iPhone,

and Nokia’s S60 platform. See Chapter 7, The Connected World,

on page 128 for an example.

Android Runtime

Also sitting on top of the kernel is the Android runtime, including the

Dalvik virtual machine and the core Java libraries.

The Dalvik VM is Google’s implementation of Java, optimized for mobile

devices. All the code you write for Android will be written in Java and

run within the VM.

2. http://www.sqlite.org

3. http://www.webkit.org
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What’s a Dalvik?

Dalvik is a virtual machine (VM) designed and written by Dan
Bornstein at Google. Your code gets compiled into machine-
independent instructions called bytecodes, which are then
executed by the Dalvik VM on the mobile device.

Although the bytecode formats are a little different, Dalvik is
essentially a Java virtual machine optimized for low memory
requirements. It allows multiple VM instances to run at once and
takes advantage of the underlying operating system (Linux) for
security and process isolation.

Bornstein named Dalvik after a �shing village in Iceland where
some of his ancestors lived.

Dalvik differs from traditional Java in two important ways:

� The Dalvik VM runs .dex �les, which are converted at compile time

from standard .class and .jar �les. .dex �les are more compact and

ef�cient than class �les, an important consideration for the limited

memory and battery-powered devices that Android targets.

� The core Java libraries that come with Android are different from

both the Java Standard Edition (Java SE) libraries and the Java

Mobile Edition (Java ME) libraries. There is a substantial amount

of overlap, however. In Appendix A, on page 217, you’ll �nd a com-

parison of Android and standard Java libraries.

Application Framework

Sitting above the native libraries and runtime, you’ll �nd the Applica-

tion Framework layer. This layer provides the high-level building blocks

you will use to create your applications. The framework comes prein-

stalled with Android, but you can also extend it with your own compo-

nents as needed.

The most important parts of the framework are as follows:

� Activity manager: This controls the life cycle of applications (see

Section 2.2, It’s Alive!, on page 33) and maintains a common

�backstack� for user navigation.
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Embrace and Extend

One of the unique and powerful qualities of Android is that all
applications have a level playing �eld. What I mean is that the
system applications have to go through the same public API
that you use. You can even tell Android to make your applica-
tion replace the standard applications if you want.

� Content providers: These objects encapsulate data that needs to be

shared between applications, such as contacts. See Section 2.3,

Content Providers, on page 38.

� Resource manager: Resources are anything that goes with your

program that is not code. See Section 2.4, Using Resources, on

page 38.

� Location manager: An Android phone always knows where it is.

See Chapter 8, Locating and Sensing, on page 156.

� Noti�cation manager: Events such as arriving messages, appoint-

ments, proximity alerts, alien invasions, and more can be pre-

sented in an unobtrusive fashion to the user.

Applications

The highest layer in the Android architecture diagram is the Applica-

tions layer. Think of this as the tip of the Android iceberg. End users will

see only these applications, blissfully unaware of all the action going on

below the waterline. As an Android developer, however, you know bet-

ter.

When someone buys an Android phone, it will come prepackaged with

a number of standard system applications, including the following:

� Phone dialer

� Email

� Contacts

� Web browser

� Android Market
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Using the Android Market, the user will be able to download new pro-

grams to run on their phone. That’s where you come in. By the time

you �nish this book, you’ll be able to write your own killer applications

for Android.

Now let’s take a closer look at the life cycle of an Android application.

It’s a little different from what you’re used to seeing.

2.2 It’s Alive!

On your standard Linux or Windows desktop, you can have many appli-

cations running and visible at once in different windows. One of the

windows has keyboard focus, but otherwise all the programs are equal.

You can easily switch between them, but it’s your responsibility as the

user to move the windows around so you can see what you’re doing and

close programs you don’t need anymore.

Android doesn’t work that way.

In Android, there is one foreground application, which typically takes

over the whole display except for the status line. When the user turns

on their phone, the �rst application they see is the Home application

(see Figure 2.2, on the following page). This program typically shows the

time, a background image, and a scrollable list of other applications the

user can invoke.

When the user runs an application, Android starts it and brings it to the

foreground. From that application, the user might invoke another appli-

cation, or another screen in the same application, and then another and

another. All these programs and screens are recorded on the applica-

tion stack by the system’s Activity Manager. At any time, the user can

press the Back button to return to the previous screen on the stack.

From the user’s point of view, it works a lot like the history in a web

browser. Pressing Back returns them to the previous page.

Process != Application

Internally, each user interface screen is represented by an Activity class

(see Section 2.3, Activities, on page 37). Each activity has its own life

cycle. An application is one or more activities plus a Linux process to

contain them. That sounds pretty straightforward, doesn’t it? But don’t

get comfortable yet; I’m about to throw you a curve ball.
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Figure 2.2: The Home application

In Android, an application can be �alive� even if its process has been

killed. Put another way, the activity life cycle is not tied to the process

life cycle. Processes are just disposable containers for activities. This is

probably different from every other system you’re familiar with, so let’s

take a closer look before moving on.

Life Cycles of the Rich and Famous

During its lifetime, each activity of an Android program can be in one

of several states, as shown in Figure 2.3, on the following page. You,

the developer, do not have control over what state your program is in.

That’s all managed by the system. However, you do get noti�ed when

the state is about to change through the onXX () method calls.
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Figure 2.3: Life cycle of an Android activity

You override these methods in your Activity class, and Android will call

them at the appropriate time:

� onCreate(Bundle): This is called when the activity �rst starts up.

You can use it to perform one-time initialization such as creating

the user interface. onCreate( ) takes one parameter that is either

null or some state information previously saved by the onSaveIn-

stanceState( ) method.

� onStart( ): This indicates the activity is about to be displayed to the

user.

� onResume( ): This is called when your activity can start interacting

with the user. This is a good place to start animations and music.
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� onPause( ): This runs when the activity is about to go into the back-

ground, usually because another activity has been launched in

front of it. This is where you should save your program’s persis-

tent state, such as a database record being edited.

� onStop( ): This is called when your activity is no longer visible to

the user and it won’t be needed for a while. If memory is tight,

onStop( ) may never be called (the system may simply terminate

your process).

� onRestart( ): If this method is called, it indicates your activity is

being redisplayed to the user from a stopped state.

� onDestroy( ): This is called right before your activity is destroyed. If

memory is tight, onDestroy( ) may never be called (the system may

simply terminate your process).

� onSaveInstanceState(Bundle): Android will call this method to allow

the activity to save per-instance state, such as a cursor position

within a text �eld. Usually you won’t need to override it because

the default implementation saves the state for all your user inter-

face controls automatically.4

� onRestoreInstanceState(Bundle): This is called when the activity is

being reinitialized from a state previously saved by the onSave-

InstanceState( ) method. The default implementation restores the

state of your user interface.

Activities that are not running in the foreground may be stopped or

the Linux process that houses them may be killed at any time in order

to make room for new activities. This will be a common occurrence,

so it’s important that your application be designed from the beginning

with this in mind. In some cases, the onPause( ) method may be the last

method called in your activity, so that’s where you should save any data

you want to keep around for next time.

In addition to managing your program’s life cycle, the Android frame-

work provides a number of building blocks that you use to create your

applications. Let’s take a look at those next.

4. Before version 0.9_beta, onSaveInstanceState( ) was called onFreeze( ), and the saved

state was called an icicle. You may still see the old names in some documentation and

examples.
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Flipping the Lid

Here’s a quick way to test that your state-saving code is working
correctly. In current versions of Android, an orientation change
(between portrait and landscape modes) will cause the system
to go through the process of saving instance state, pausing,
stopping, destroying, and then creating a new instance of the
activity with the saved state. On the T-Mobile G1 phone, for
example, �ipping the lid on the keyboard will trigger this, and
on the Android emulator pressing Ctrl+F11 or the 7 or 9 key
on the keypad will do it.

2.3 Building Blocks

A few objects are de�ned in the Android SDK that every developer needs

to be familiar with. The most important ones are activities, intents,

services, and content providers. You’ll see several examples of them in

the rest of the book, so I’d like to brie�y introduce them now.

Activities

An activity is a user interface screen. Applications can de�ne one or

more activities to handle different phases of the program. As discussed

in Section 2.2, It’s Alive!, on page 33, each activity is responsible for

saving its own state so that it can be restored later as part of the

application life cycle. See Section 3.3, Creating the Opening Screen, on

page 44 for an example.

Intents

An intent is a mechanism for describing a speci�c action, such as �pick

a photo,� �phone home,� or �open the pod bay doors.� In Android, just

about everything goes through intents, so you have plenty of opportu-

nities to replace or reuse components. See Section 3.5, Implementing

an About Box, on page 55 for an example of an intent.

For example, there is an intent for �send an email.� If your application

needs to send mail, you can invoke that intent. Or if you’re writing a

new email application, you can register an activity to handle that intent

and replace the standard mail program. The next time somebody tries

to send an email, they’ll get your program instead of the standard one.
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Services

A service is a task that runs in the background without the user’s direct

interaction, similar to a Unix daemon. For example, consider a music

player. The music may be started by an activity, but you want it to

keep playing even when the user has moved on to a different program.

So, the code that does the actual playing should be in a service. Later,

another activity may bind to that service and tell it to switch tracks

or stop playing. Android comes with many services built in, along with

convenient APIs to access them.

Content Providers

A content provider is a set of data wrapped up in a custom API to read

and write it. This is the best way to share global data between appli-

cations. For example, Google provides a content provider for contacts.

All the information there�names, addresses, phone numbers, and so

forth�can be shared by any application that wants to use it. See Sec-

tion 9.5, Using a ContentProvider, on page 186 for an example.

2.4 Using Resources

A resource is a localized text string, bitmap, or other small piece of

noncode information that your program needs. At build time all your

resources get compiled into your application.

You will create and store your resources in the res directory inside your

project. The Android resource compiler (aapt)5 processes resources

according to which subfolder they are in and the format of the �le. For

example, PNG and JPG format bitmaps should go in the res/drawable

directory, and XML �les that describe screen layouts should go in the

res/layout directory.

The resource compiler compresses and packs your resources and then

generates a class named R that contains identi�ers you use to reference

those resources in your program. This is a little different from standard

Java resources, which are referenced by key strings. Doing it this way

allows Android to make sure all your references are valid and saves

space by not having to store all those resource keys. Eclipse uses a

similar method to store and reference the resources in Eclipse plug-ins.

5. http://d.android.com/guide/developing/tools/aapt.html
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We’ll see an example of the code to access a resource in Chapter 3,

Designing the User Interface, on page 42.

2.5 Safe and Secure

As mentioned earlier, every application runs in its own Linux process.

The hardware forbids one process from accessing another process’s

memory. Furthermore, every application is assigned a speci�c user ID.

Any �les it creates cannot be read or written by other applications.

In addition, access to certain critical operations are restricted, and you

must speci�cally ask for permission to use them in a �le named Android-

Manifest.xml. When the application is installed, the Package Manager

either grants or doesn’t grant the permissions based on certi�cates

and, if necessary, user prompts. Here are some of the most common

permissions you will need:

� INTERNET: Access the Internet.

� READ_CONTACTS: Read (but don’t write) the user’s contacts data.

� WRITE_CONTACTS: Write (but don’t read) the user’s contacts data.

� RECEIVE_SMS: Monitor incoming SMS (text) messages.

� ACCESS_COARSE_LOCATION: Use a coarse location provider such as

cell towers or wi�.

� ACCESS_FINE_LOCATION: Use a more accurate location provider such

as GPS.

For example, to monitor incoming SMS messages, you would specify

this in the manifest �le:

<manifest xmlns:android="http://schemas.android.com/apk/res/android"

package="com.google.android.app.myapp" >

<uses-permission android:name="android.permission.RECEIVE_SMS" />

</manifest>

Android can even restrict access to entire parts of the system. Using

XML tags in AndroidManifest.xml, you can restrict who can start an activ-

ity, start or bind to a service, broadcast intents to a receiver, or access

the data in a content provider. This kind of control is beyond the scope

of this book, but if you want to learn more, read the online help for the

Android security model.6

6. http://d.android.com/guide/topics/security/security.html
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2.6 Fast-Forward >>

The rest of this book will use all the concepts introduced in this chap-

ter. In Chapter 3, Designing the User Interface, on page 42, we’ll use

activities and life-cycle methods to de�ne a sample application. Chap-

ter 4, Exploring 2D Graphics, on page 71 will use some of the graphics

classes in the Android native libraries. Media codecs will be explored

in Chapter 5, Multimedia, on page 102, and content providers will be

covered in Chapter 9, Putting SQL to Work, on page 173.
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Chapter 3

Designing the User Interface
In Chapter 1, Quick Start, on page 18, we used the Android Eclipse

plug-in to put together a simple �Hello, Android� program in a few min-

utes. In Part II, we’ll create a more substantial example: a Sudoku

game. By gradually adding features to the game, you’ll learn about

many aspects of Android programming. We’ll start with the user inter-

face.

You can �nd all the sample code used in this book at http://pragprog.

com/titles/eband. If you’re reading the PDF version of this book, you can

click the little gray rectangle before the code listings to download that

�le directly.

3.1 Introducing the Sudoku Example

Sudoku makes a great sample program for Android because the game

itself is so simple. You have a grid of eighty-one tiles (nine across and

nine down), and you try to �ll them in with numbers so that each col-

umn, each row, and each of the three-by-three boxes contains the num-

bers 1 through 9 only once. When the game starts, some of the numbers

(the givens) are already �lled in. All the player has to do is supply the

rest. A true Sudoku puzzle has only one unique solution.

Sudoku is usually played with pencil and paper, but computerized ver-

sions are quite popular too. With the paper version, it’s easy to make

a mistake early on, and when that happens, you have to go back and

erase most of your work. In the Android version, you can change the

tiles as often as you like without having to brush away all those pesky

eraser shavings.
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Sudoku Trivia

Most people think Sudoku is some kind of ancient Japanese
game, but it’s not. Although similar puzzles can be traced
to 19th-century French magazines, most experts credit retired
American architect Howard Garns with the invention of mod-
ern Sudoku. Number Place, as it was known at the time, was
�rst published in the United States in 1979 by Dell Magazines.

Android Sudoku (see Figure 3.1, on the next page) will also offer a

few hints to take some of the grunt work out of puzzle solving. At one

extreme, it could just solve the puzzle for you, but that wouldn’t be any

fun, would it? So, we have to balance the hints against the challenge

and not make it too easy.

3.2 Designing by Declaration

User interfaces can be designed using one of two methods: procedural

and declarative. Procedural simply means in code. For example, when

you’re programming a Swing application, you write Java code to cre-

ate and manipulate all the user interface objects such as JFrame and

JButton. Thus, Swing is procedural.

Declarative design, on the other hand, does not involve any code. When

you’re designing a simple web page, you use HTML, a markup language

based on XML that describes what you want to see on the page, not how

you want to do it. HTML is declarative.

Android tries to straddle the gap between the procedural and declar-

ative worlds by letting you create user interfaces in either style. You

can stay almost entirely in Java code, or you can stay almost entirely

in XML descriptors. If you look up the documentation for any Android

user interface component, you’ll see both the Java APIs and the corre-

sponding declarative XML attributes that do the same thing.

Which should you use? Either way is valid, but my advice is to use

declarative XML as much as possible. The XML code is often shorter

and easier to understand than the corresponding Java code, and future

tools that might be developed for Android, such as GUI designers, will

have an easier time working with it.
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Figure 3.1: The Sudoku example program for Android

Now let’s see how we can use this information to create the Sudoku

opening screen.

3.3 Creating the Opening Screen

We’ll start with a skeleton Android program created by the Eclipse plug-

in. Just as you did in Section 1.2, Creating Your First Program, on

page 22, create a new �Hello, Android� project, but this time use the

following values:

Project name: Sudoku

Package name: org.example.sudoku

Activity name: Sudoku

Application name: Sudoku

In a real program, of course, you would use your own names here. The

package name is particularly important. Each application in the system
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must have a unique package name. Once you choose a package name,

it’s a little tricky to change it because it’s used in so many places.

I like to keep the Android emulator window up all the time and run the

program after every change, since it takes only a few seconds. If you

do that and run the program now, you’ll see a blank screen that just

contains the words �Hello World, Sudoku.� The �rst order of business is

to change that into an opening screen for the game, with buttons to let

the player start a new game, continue a previous one, get information

about the game, or exit. So, what do we have to change to do that?

As discussed in Chapter 2, Key Concepts, on page 28, Android pro-

grams are a loose collection of activities, each of which de�ne a user

interface screen. When you create the Sudoku project, the Android

plug-in makes a single activity for you in Sudoku.java:

Download Sudokuv0/src/org/example/sudoku/Sudoku.java

package org.example.sudoku;

import android.app.Activity;

import android.os.Bundle;

public class Sudoku extends Activity {

/** Called when the activity is first created. */

@Override

public void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);

setContentView(R.layout.main);

}

}

Android calls the onCreate( ) method of your activity to initialize it. The

call to setContentView( ) �lls in the contents of the activity’s screen with

an Android view widget.

We could have used several lines of Java code, and possibly another

class or two, to de�ne the user interface procedurally. But instead,

the plug-in chose the declarative route, and we’ll continue along those

lines. In the previous code, R.layout.main is a resource identi�er that

refers to the main.xml �le in the res/layout directory (see Figure 3.2, on the

following page). main.xml declares the user interface in XML, so that’s

the �le we need to modify. At runtime, Android parses and instanti-

ates (in�ates) the resource de�ned there and sets it as the view for the

current activity.

It’s important to note that the R class is managed automatically by the

Android Eclipse plug-in. When you put a �le anywhere in the res direc-
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Figure 3.2: Initial resources in the Sudoku project

tory, the plug-in notices the change and adds resource IDs in R.java

in the gen directory for you. If you remove or change a resource �le,

R.java is kept in sync. If you bring up the �le in the editor, it will look

something like this:

Download Sudokuv0/gen/org/example/sudoku/R.java

/* AUTO-GENERATED FILE. DO NOT MODIFY.

*

* This class was automatically generated by the

* aapt tool from the resource data it found. It

* should not be modified by hand.

*/

package org.example.sudoku;

public final class R {

public static final class attr {

}

public static final class drawable {

public static final int icon=0x7f020000;

}

public static final class layout {

public static final int main=0x7f030000;

}

public static final class string {

public static final int app_name=0x7f040001;

public static final int hello=0x7f040000;
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Joe Asks. . .

Why Does Android Use XML? Isn’t That Inef�cient?

Android is optimized for mobile devices with limited memory
and horsepower, so you may �nd it strange that it uses XML so
pervasively. After all, XML is a verbose, human-readable format
not known for its brevity or ef�ciency, right?

Although you see XML when writing your program, the Eclipse
plug-in invokes the Android resource compiler, aapt, to prepro-
cess the XML into a compressed binary format. It is this format,
not the original XML text, that is stored on the device.

}

}

The hex numbers are just integers that the Android resource manager

uses to load the real data, the strings, and the other assets that are

compiled into your package. You don’t need to worry about their values.

Just keep in mind that they are handles that refer to the data, not the

objects that contain the data. Those objects won’t be in�ated until they

are needed. Note that almost every Android program, including the base

Android framework itself, has an R class. See the online documentation

on android.R for all the built-in resources you can use.1

So, now we know we have to modify main.xml. Let’s dissect the origi-

nal de�nition to see what we have to change. Double-click main.xml in

Eclipse to open it. Depending on how you have Eclipse set up, you may

see either a visual layout editor or an XML editor. In current versions

of ADT, the visual layout editor isn’t that useful, so click main.xml or

Source tab at the bottom to see the XML.

The �rst line of main.xml is as follows:

<?xml version="1.0" encoding="utf-8"?>

All Android XML �les start with this line. It just tells the compiler that

the �le is XML format, in UTF-8 encoding. UTF-8 is almost exactly like

regular ASCII text, except it has escape codes for non-ASCII characters

such as Japanese glyphs.

1. http://d.android.com/reference/android/R.html
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Next we see a reference to <LinearLayout>:

<LinearLayout

xmlns:android="http://schemas.android.com/apk/res/android"

android:orientation="vertical"

android:layout_width="fill_parent"

android:layout_height="fill_parent">

<!-- ... -->

</LinearLayout>

A layout is a container for one or more child objects and a behavior to

position them on the screen within the rectangle of the parent object.

Here is a list of the most common layouts provided by Android:

� FrameLayout: Arranges its children so they all start at the top left

of the screen. This is used for tabbed views and image switchers.

� LinearLayout: Arranges its children in a single column or row. This

is the most common layout you will use.

� RelativeLayout: Arranges its children in relation to each other or to

the parent. This is often used in forms.

� TableLayout: Arranges its children in rows and columns, similar to

an HTML table.

Some parameters are common to all layouts:

xmlns:android="http://schemas.android.com/apk/res/android"

De�nes the XML namespace for Android. You should de�ne this

once, on the �rst XML tag in the �le.

android:layout_width="�ll_parent", android:layout_height="�ll_parent"

Takes up the entire width and height of the parent (in this case,

the window). Possible values are �ll_parent and wrap_content.

Inside the <LinearLayout> tag you’ll �nd one child widget:

<TextView

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/hello" />

This de�nes a simple text label. Let’s replace that with some different

text and a few buttons. Here’s our �rst attempt:

Download Sudokuv1/res/layout/main1.xml

<?xml version="1.0" encoding="utf-8"?>

<LinearLayout

xmlns:android="http://schemas.android.com/apk/res/android"

android:orientation="vertical"

android:layout_width="fill_parent"

android:layout_height="fill_parent">
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<TextView

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/main_title" />

<Button

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/continue_label" />

<Button

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/new_game_label" />

<Button

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/about_label" />

<Button

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/exit_label" />

</LinearLayout>

If you see warnings in the editor about missing grammar constraints

(DTD or XML schema), just ignore them.

Instead of hard-coding English text into the layout �le, we use the

@string/resid syntax to refer to strings in the res/values/strings.xml �le. You

can have different versions of this and other resource �les based on the

locale or other parameters such as screen resolution and orientation.

Open that �le now, switch to the strings.xml tab at the bottom if neces-

sary, and enter this:

Download Sudokuv1/res/values/strings.xml

<?xml version="1.0" encoding="utf-8"?>

<resources>

<string name="app_name">Sudoku</string>

<string name="main_title">Android Sudoku</string>

<string name="continue_label">Continue</string>

<string name="new_game_label">New Game</string>

<string name="about_label">About</string>

<string name="exit_label">Exit</string>

</resources>

When you run the program now, you should see something like Fig-

ure 3.3, on the next page. It’s readable, but it could use some cosmetic

changes.
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Figure 3.3: First version of the opening screen

Let’s make the title text larger and centered, make the buttons smaller,

and use a different background color. Here’s the color de�nition, which

you should put in res/values/colors.xml:

Download Sudokuv1/res/values/colors.xml

<?xml version="1.0" encoding="utf-8"?>

<resources>

<color name="background">#3500ffff</color>

</resources>

And here’s the new layout:

Download Sudokuv1/res/layout/main.xml

<?xml version="1.0" encoding="utf-8"?>

<LinearLayout

xmlns:android="http://schemas.android.com/apk/res/android"

android:background="@color/background"

android:layout_height="fill_parent"

android:layout_width="fill_parent"
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android:padding="30dip"

android:orientation="horizontal">

<LinearLayout

android:orientation="vertical"

android:layout_height="wrap_content"

android:layout_width="fill_parent"

android:layout_gravity="center">

<TextView

android:text="@string/main_title"

android:layout_height="wrap_content"

android:layout_width="wrap_content"

android:layout_gravity="center"

android:layout_marginBottom="25dip"

android:textSize="24.5sp" />

<Button

android:id="@+id/continue_button"

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/continue_label" />

<Button

android:id="@+id/new_button"

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/new_game_label" />

<Button

android:id="@+id/about_button"

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/about_label" />

<Button

android:id="@+id/exit_button"

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/exit_label" />

</LinearLayout>

</LinearLayout>

In this version, we introduce a new syntax, @+id/resid. Instead of refer-

ring to a resource ID de�ned somewhere else, this is how you create

a new resource ID to which others can refer. For example, @+id/about_

button de�nes the ID for the About button, which we’ll use later to make

something happen when the user presses that button.

The result is shown in Figure 3.4, on the following page. This new

screen looks good in portrait mode (when the screen is taller than it

is wide), but how about landscape mode (wide-screen)? The user can

switch modes at any time, for example, by �ipping out the keyboard

and turning the phone on its side, so you need to handle that.
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Figure 3.4: Opening screen with new layout

3.4 Using Alternate Resources

As a test, try switching the emulator to landscape mode ( Ctrl+F11 or

the 7 or 9 key on the keypad). Oops! The Exit button runs off the

bottom of the screen (see Figure 3.5, on page 54). How do we �x that?

You could try to adjust the layout so that it works with all orienta-

tions. Unfortunately, that’s often not possible or leads to odd-looking

screens. When that happens, you’ll need to create a different layout for

landscape mode. That’s the approach we’ll take here.
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Joe Asks. . .

What Are Dips and Sps?

Historically, programmers always designed computer interfaces
in terms of pixels. For example, you might make a �eld 300 pixels
wide, allow 5 pixels of spacing between columns, and de�ne
icons 16-by-16 pixels in size. The problem is that if you run that
program on new displays with more and more dots per inch
(dpi), the user interface appears smaller and smaller. At some
point, it becomes too hard to read.

Resolution-independent measurements help solve this problem.
Android supports all the following units:

� px (pixels): Dots on the screen.

� in (inches): Size as measured by a ruler.

� mm (millimeters): Size as measured by a ruler.

� pt (points): 1/72 of an inch.

� dp (density-independent pixels): An abstract unit based
on the density of the screen. On a display with 160 dots
per inch, 1dp = 1px.

� dip: Synonym for dp, used more often in Google examples.

� sp (scale-independent pixels): Similar to dp but also scaled
by the user’s font size preference.

To make your interface scalable to any current and future type
of display, I recommend you always use the sp unit for text sizes
and the dip unit for everything else. You should also consider
using vector graphics instead of bitmaps (see Chapter 4, Explor-
ing 2D Graphics, on page 71).
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Figure 3.5: In landscape mode, we can’t see the Exit button.

Create a �le called res/layout-land/main.xml (note the -land suf�x) that

contains the following layout:

Download Sudokuv1/res/layout-land/main.xml

<?xml version="1.0" encoding="utf-8"?>

<LinearLayout

xmlns:android="http://schemas.android.com/apk/res/android"

android:background="@color/background"

android:layout_height="fill_parent"

android:layout_width="fill_parent"

android:padding="15dip"

android:orientation="horizontal">

<LinearLayout

android:orientation="vertical"

android:layout_height="wrap_content"

android:layout_width="fill_parent"

android:layout_gravity="center"

android:paddingLeft="20dip"

android:paddingRight="20dip">

<TextView

android:text="@string/main_title"

android:layout_height="wrap_content"

android:layout_width="wrap_content"

android:layout_gravity="center"

android:layout_marginBottom="20dip"

android:textSize="24.5sp" />
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<TableLayout

android:layout_height="wrap_content"

android:layout_width="wrap_content"

android:layout_gravity="center"

android:stretchColumns="*">

<TableRow>

<Button

android:id="@+id/continue_button"

android:text="@string/continue_label" />

<Button

android:id="@+id/new_button"

android:text="@string/new_game_label" />

</TableRow>

<TableRow>

<Button

android:id="@+id/about_button"

android:text="@string/about_label" />

<Button

android:id="@+id/exit_button"

android:text="@string/exit_label" />

</TableRow>

</TableLayout>

</LinearLayout>

</LinearLayout>

This uses a TableLayout to create two columns of buttons. Now run the

program again (see Figure 3.6, on the next page). Even in landscape

mode, all the buttons are visible.

You can use resource suf�xes to specify alternate versions of any re-

sources, not just the layout. For example, you can use them to provide

localized text strings in different languages. Each alternate resource �le

must de�ne exactly the same set of IDs.

Android supports suf�xes for the current language, region, pixel den-

sity, resolution, input method, and more. See the Android resources

documentation for an up-to-date list of suf�xes and inheritance rules.2

3.5 Implementing an About Box

When the user selects the About button, meaning that either they touch

it (if they have a touch screen) or they navigate to it with the D-pad

(directional pad) or trackball and press the selection button, we want

to pop up a window with some information about Sudoku.

2. http://d.android.com/guide/topics/resources/resources-i18n.html#AlternateResources
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Figure 3.6: Using a landscape-speci�c layout lets us see all the buttons.

After scrolling through the text, the user can press the Back button to

dismiss the window.

We can accomplish this in several ways:

� De�ne a new Activity and start it.

� Use the AlertDialog class and show it.

� Subclass Android’s Dialog class, and show that.

For this example, let’s de�ne a new activity. Like the main Sudoku activ-

ity, the About activity will need a layout �le. We will name it res/layout/

about.xml:

Download Sudokuv1/res/layout/about.xml

<?xml version="1.0" encoding="utf-8"?>

<ScrollView

xmlns:android="http://schemas.android.com/apk/res/android"

android:layout_width="fill_parent"

android:layout_height="fill_parent"

android:padding="10dip">

<TextView

android:id="@+id/about_content"

android:layout_width="wrap_content"

android:layout_height="wrap_content"

android:text="@string/about_text" />

</ScrollView>
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We need only one version of this layout because it will look �ne in both

portrait and landscape modes.

Now add strings for the title of the About dialog box and the text it

contains to res/values/strings.xml:

Download Sudokuv1/res/values/strings.xml

<string name="about_title">About Android Sudoku</string>

<string name="about_text">\

Sudoku is a logic-based number placement puzzle.

Starting with a partially completed 9x9 grid, the

objective is to fill the grid so that each

row, each column, and each of the 3x3 boxes

(also called <i>blocks</i>) contains the digits

1 to 9 exactly once.

</string>

Note how a string resource can contain simple HTML formatting and

can span multiple lines. In case you’re wondering, the backslash char-

acter (\) in about_text prevents an extra blank from appearing before

the �rst word.

The About activity should be de�ned in About.java. All it needs to do is

override onCreate( ) and call setContentView( ):

Download Sudokuv1/src/org/example/sudoku/About.java

package org.example.sudoku;

import android.app.Activity;

import android.os.Bundle;

public class About extends Activity {

@Override

protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);

setContentView(R.layout.about);

}

}

Next we need to wire all this up to the About button in the Sudoku class.

Start by adding a few imports we’ll need to Sudoku.java:

Download Sudokuv1/src/org/example/sudoku/Sudoku.java

import android.content.Intent;

import android.view.View;

import android.view.View.OnClickListener;
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In the onCreate( ) method, add code to call �ndViewById( ) to look up an

Android view given its resource ID and setOnClickListener( ) to tell Android

which object to tickle when the user touches or clicks the view:

Download Sudokuv1/src/org/example/sudoku/Sudoku.java

/** Called when the activity is first created. */

@Override

public void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);

setContentView(R.layout.main);

// Set up click listeners for all the buttons

View continueButton = this.findViewById(R.id.continue_button);

continueButton.setOnClickListener(this);

View newButton = this.findViewById(R.id.new_button);

newButton.setOnClickListener(this);

View aboutButton = this.findViewById(R.id.about_button);

aboutButton.setOnClickListener(this);

View exitButton = this.findViewById(R.id.exit_button);

exitButton.setOnClickListener(this);

}

While we’re in here, we do the same for all the buttons. Recall that

constants like R.id.about_button are created by the Eclipse plug-in in

R.java when it sees @+id/about_button in res/layout/main.xml.

The code uses this as the receiver, so the Sudoku class needs to imple-

ment the OnClickListener interface and de�ne a method called onClick:3

Download Sudokuv1/src/org/example/sudoku/Sudoku.java

public class Sudoku extends Activity implements OnClickListener {

// ...

public void onClick(View v) {

switch (v.getId()) {

case R.id.about_button:

Intent i = new Intent(this, About.class);

startActivity(i);

break;

// More buttons go here (if any) ...

}

}

}

To start an activity in Android, we �rst need to create an instance of

the Intent class. There are two kinds of intents: public (named) intents

3. We could have used an anonymous inner class to handle clicks, but according to the

Android developers, every new inner class takes up an extra 1KB of memory.
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Figure 3.7: Mountain View, we have a problem

that are registered with the system and can be called from any appli-

cation and private (anonymous) intents that are used within a single

application. For this example, we just need the latter kind.

If you run the program and select the About button now, you will get

an error (see Figure 3.7). What happened?

We forgot one important step: every activity needs to be declared in

AndroidManifest.xml. To do that, double-click the �le to open it, switch

to XML mode if necessary by selecting the AndroidManifest.xml tab at the

bottom, and add a new <activity> tag after the closing tag of the �rst

one:

Download Sudokuv1/AndroidManifest.�rst.xml

<activity android:name=".About"

android:label="@string/about_title">

</activity>

Now if you save the manifest, run the program again, and select the

About button, you should see something like Figure 3.8, on the next

page. Press the Back button ( Esc on the emulator) when you’re done.

That looks OK, but wouldn’t it be nice if we could see the initial screen

behind the About text?
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Figure 3.8: First version of the About screen

3.6 Applying a Theme

A theme is a collection of styles that override the look and feel of Android

widgets. Themes were inspired by Cascading Style Sheets (CSS) used

for web pages�they separate the content of a screen and its presen-

tation or style. Android is packaged with several themes that you can

reference by name,4 or you can make up your own theme by subclass-

ing existing ones and overriding their default values.

We could de�ne our own custom theme in res/values/styles.xml, but for

this example we’ll just take advantage of a prede�ned one. To use it,

open the AndroidManifest.xml editor again, and change the de�nition of

the About activity so it has a theme property.

4. See http://d.android.com/reference/android/R.style.html for symbols beginning with

�Theme_.�
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Figure 3.9: About screen after applying the dialog box theme

Download Sudokuv1/AndroidManifest.xml

<activity android:name=".About"

android:label="@string/about_title"

android:theme="@android:style/Theme.Dialog">

</activity>

The @android: pre�x in front of the style name means this is a refer-

ence to a resource de�ned by Android, not one that is de�ned in your

program.

Running the program again, the About box now looks like Figure 3.9.

Many programs need menus and options, so the next two sections will

show you how to de�ne them.

3.7 Adding a Menu

Android supports two kinds of menus. First, there is the menu you get

when you press the Menu button. Second, there is a context menu that
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Joe Asks. . .

Why Not Use an HTML View?

Android supports embedding a web browser directly into a
view through the WebView class (see Section 7.2, Web with a
View , on page 132). So, why didn’t we just use that for the
About box?

Actually, you could do it either way. A WebView would support
far more sophisticated formatting than a simple TextView, but
it does have some limitations (such as the inability to use a
transparent background). Also, WebView is a heavyweight wid-
get that will be slower and take more memory than TextView.
For your own applications, use whichever one makes the most
sense for your needs.

pops up when you press and hold your �nger on the screen (or press

and hold the D-pad center button).

Let’s do the �rst kind so that when the user presses the Menu key,

they’ll open a menu like the one in Figure 3.10, on the following page.

First we need to de�ne a few strings that we’ll use later:

Download Sudokuv1/res/values/strings.xml

<string name="settings_label">Settings...</string>

<string name="settings_title">Sudoku settings</string>

<string name="settings_shortcut">s</string>

<string name="music_title">Music</string>

<string name="music_summary">Play background music</string>

<string name="hints_title">Hints</string>

<string name="hints_summary">Show hints during play</string>

Then we de�ne the menu using XML in res/menu/menu.xml:

Download Sudokuv1/res/menu/menu.xml

<?xml version="1.0" encoding="utf-8"?>

<menu xmlns:android="http://schemas.android.com/apk/res/android">

<item android:id="@+id/settings"

android:title="@string/settings_label"

android:alphabeticShortcut="@string/settings_shortcut" />

</menu>
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Figure 3.10: Press the Menu button to open the menu.

Next we need to modify the Sudoku class to bring up the menu we just

de�ned. To do that, we’ll need a few more imports:

Download Sudokuv1/src/org/example/sudoku/Sudoku.java

import android.view.Menu;

import android.view.MenuInflater;

import android.view.MenuItem;

Then we override the Sudoku.onCreateOptionsMenu( ) method:

Download Sudokuv1/src/org/example/sudoku/Sudoku.java

@Override

public boolean onCreateOptionsMenu(Menu menu) {

super.onCreateOptionsMenu(menu);

MenuInflater inflater = getMenuInflater();

inflater.inflate(R.menu.menu, menu);

return true;

}

getMenuIn�ater( ) returns an instance of MenuIn�ater that we use to read

the menu de�nition from XML and turns it into a real view.

When the user selects any menu item, onOptionsItemSelected( ) will be

called. Here’s the de�nition for that method:

Download Sudokuv1/src/org/example/sudoku/Sudoku.java

@Override

public boolean onOptionsItemSelected(MenuItem item) {

switch (item.getItemId()) {

case R.id.settings:

startActivity(new Intent(this, Settings.class));

return true;

// More items go here (if any) ...

}

return false;

}
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Settings is a class that we’re going to de�ne that displays all our prefer-

ences and allows the user to change them.

3.8 Adding Settings

Android provides a nice facility for de�ning what all your program pref-

erences are and how to display them using almost no code. You de�ne

the preferences in a resource �le called res/xml/settings.xml:

Download Sudokuv1/res/xml/settings.xml

<?xml version="1.0" encoding="utf-8"?>

<PreferenceScreen

xmlns:android="http://schemas.android.com/apk/res/android">

<CheckBoxPreference

android:key="music"

android:title="@string/music_title"

android:summary="@string/music_summary"

android:defaultValue="true" />

<CheckBoxPreference

android:key="hints"

android:title="@string/hints_title"

android:summary="@string/hints_summary"

android:defaultValue="true" />

</PreferenceScreen>

The Sudoku program has two settings: one for background music and

one for displaying hints. The keys are constant strings that will be used

under the covers in Android’s preferences database.

Next de�ne the Settings class, and make it extend PreferenceActivity:

Download Sudokuv1/src/org/example/sudoku/Settings.java

package org.example.sudoku;

import android.os.Bundle;

import android.preference.PreferenceActivity;

public class Settings extends PreferenceActivity {

@Override

protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);

addPreferencesFromResource(R.xml.settings);

}

}

The addPreferencesFromResource( ) method reads the settings de�nition

from XML and in�ates it into views in the current activity. All the heavy

lifting takes place in the PreferenceActivity class.
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Figure 3.11: It’s not much to look at, but we got it for free.

Don’t forget to register the Settings activity in AndroidManifest.xml:

Download Sudokuv1/AndroidManifest.xml

<activity android:name=".Settings"

android:label="@string/settings_title">

</activity>

Now rerun Sudoku, press the Menu key, select the Settings... item,

and watch with amazement as the Sudoku settings page appears (see

Figure 3.11). Try changing the values there and exiting the program,

and then come back in and make sure they’re all still set.

Code that reads the settings and does something with them will be

discussed in a different chapter (Chapter 6, Storing Local Data, on

page 117). For now let’s move on to the New Game button.
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3.9 Starting a New Game

If you’ve played any Sudoku games, you know that some are easy and

some are maddeningly hard. So when the user selects New Game, we

want to pop up a dialog box asking them to select between three dif�-

culty levels. Selecting from a list of things is easy to do in Android. First

we’ll need a few more strings in res/values/strings.xml.

Download Sudokuv1/res/values/strings.xml

<string name="new_game_title">Difficulty</string>

<string name="easy_label">Easy</string>

<string name="medium_label">Medium</string>

<string name="hard_label">Hard</string>

Create the list of dif�culties as an array resource in res/values/arrays.xml:

Download Sudokuv1/res/values/arrays.xml

<?xml version="1.0" encoding="utf-8"?>

<resources>

<array name="difficulty">

<item>@string/easy_label</item>

<item>@string/medium_label</item>

<item>@string/hard_label</item>

</array>

</resources>

We’ll need a few more imports in the Sudoku class:

Download Sudokuv1/src/org/example/sudoku/Sudoku.java

import android.app.AlertDialog;

import android.content.DialogInterface;

import android.util.Log;

Add code in the switch statement of the onClick( ) method to handle a

click on the New Game button:

Download Sudokuv1/src/org/example/sudoku/Sudoku.java

case R.id.new_button:

openNewGameDialog();

break;

The openNewGameDialog( ) method takes care of creating the user inter-

face for the dif�culty list.
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Figure 3.12: Dif�culty selection dialog box

Download Sudokuv1/src/org/example/sudoku/Sudoku.java

private static final String TAG = "Sudoku";

/** Ask the user what difficulty level they want */

private void openNewGameDialog() {

new AlertDialog.Builder(this)

.setTitle(R.string.new_game_title)

.setItems(R.array.difficulty,

new DialogInterface.OnClickListener() {

public void onClick(DialogInterface dialoginterface,

int i) {

startGame(i);

}

})

.show();

}

/** Start a new game with the given difficulty level */

private void startGame(int i) {

Log.d(TAG, "clicked on " + i);

// Start game here...

}
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Figure 3.13: Debugging output in the LogCat view

The setItems( ) method takes two parameters: the resource ID of the item

list and a listener that will be called when one of the items is selected.

When you run the program now and press New Game, you’ll get the

dialog box in Figure 3.12, on the previous page.

We’re not actually going to start the game yet, so instead when you

select a dif�culty level, we just print a debug message using the Log.d( )

method, passing it a tag string and a message to print.

3.10 Debugging with Log Messages

The Log class provides several static methods to print messages of var-

ious severity levels to the Android system log:

� Log.e( ): Errors

� Log.w( ): Warnings

� Log.i( ): Information

� Log.d( ): Debugging

� Log.v( ): Verbose

Users will never see this log, but as a developer you can view it in a

couple ways. In Eclipse, open the LogCat view by selecting Window >

Show View > Other... > Android > LogCat (see Figure 3.13). The view

can be �ltered by severity or by the tag you speci�ed on the method

call.
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If you’re not using Eclipse, you can see the same output by running

the adb logcat command.5 I recommend you start this command in a

separate window and leave it running all the time that the emulator is

running. It won’t interfere with any other monitors.

I can’t stress enough how useful the Android log will be during devel-

opment. Remember that error we saw earlier with the About box (Fig-

ure 3.7, on page 59)? If you had opened the LogCat view at that point,

you would have seen this message: �ActivityNotFoundException: Un-

able to �nd explicit activity class...have you declared this activity in

your AndroidManifest.xml?� It doesn’t get any plainer than that.

3.11 Debugging with the Debugger

In addition to log messages, you can use the Eclipse debugger to set

breakpoints, single step, and view the state of your program. First, en-

able your project for debugging by adding the android:debuggable="true"

option in your AndroidManifest.xml �le:6

Download Sudokuv1/AndroidManifest.xml

<application android:icon="@drawable/icon"

android:label="@string/app_name"

android:debuggable="true">

Then, simply right-click the project, and select Debug As > Android

Application.

3.12 Exiting the Game

This game doesn’t really need an Exit button, because the user can just

press the Back key or the Home key to do something else. But I wanted

to add one to show you how to terminate an activity. Add this to the

switch statement in the onClick( ) method:

Download Sudokuv1/src/org/example/sudoku/Sudoku.java

case R.id.exit_button:

finish();

break;

5. http://d.android.com/guide/developing/tools/adb.html

6. This is optional if you’re using the emulator but required on a real device. Just

remember to remove the option before releasing your code to the public.
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When the Exit button is selected, we call the �nish( ) method. This shuts

down the activity and returns control to the next activity on the Android

application stack (usually the Home screen).

3.13 Fast-Forward >>

Whew, that was a lot to cover in one chapter! Starting from scratch, you

learned how to use layout �les to organize your user interface and how

to use Android resources for text, colors, and more. You added controls

such as buttons and text �elds, applied themes to change the program’s

appearance, and even added menus and preferences for good measure.

Android is a complex system, but you don’t have to know all of it to

get started. When you need help, the hundreds of pages of reference

material online go into more depth on all the classes and methods used

here.7

In Chapter 4, Exploring 2D Graphics, on the following page, we’ll use

Android’s graphics API to draw the tiles for the Sudoku game.

7. To view the online documentation, open documentation.html from your Android SDK

install location, or point your browser to http://d.android.com/guide/index.html.
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Chapter 4

Exploring 2D Graphics
So far, we’ve covered the basic concepts and philosophy of Android and

how to create a simple user interface with a few buttons and a dialog

box. You’re really starting to get the hang of this Android thing. But

something is missing...what is it? Oh yeah, the fun!

Good graphics can add a bit of fun and excitement to any application.

Android puts one of the most powerful graphics libraries available on a

mobile device at your �ngertips. Actually, it puts two of them there: one

for two-dimensional graphics and one for three-dimensional graphics.1

In this chapter, we will cover 2D graphics and apply that knowledge

to implement the game part of our Sudoku example. Chapter 10, 3D

Graphics in OpenGL, on page 193 will cover 3D graphics using the

OpenGL ES library.

4.1 Learning the Basics

Android provides a complete native two-dimensional graphics library

in its android.graphics package. With a basic understanding of classes

such as Color and Canvas, you’ll be up and drawing in no time.

Color

Android colors are represented with four numbers, one each for alpha,

red, green, and blue (ARGB). Each component can have 256 possible

values, or 8 bits, so a color is typically packed into a 32-bit integer. For

1. Functionality for four-dimensional graphics was considered for Android, but it was

dropped because of a lack of time.
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ef�ciency, Android code uses an integer instead of an instance of the

Color class.

Red, green, and blue are self-explanatory, but alpha might not be.

Alpha is a measure of transparency. The lowest value, 0, indicates the

color is completely transparent. It doesn’t really matter what the val-

ues for RGB are, if A is 0. The highest value, 255, indicates the color

is completely opaque. Values in the middle are used for translucent, or

semitransparent, colors. They let you see some of what is underneath

the object being drawn in the foreground.

To create a color, you can use one of the static constants on the Color

class, like this:

int color = Color.BLUE; // solid blue

or if you know the alpha, red, green, and blue numbers, you can use

one of the static factory methods such as the following:

// Translucent purple

color = Color.argb(127, 255, 0, 255);

If possible, though, you’re usually better off de�ning all your colors in

an XML resource �le. This lets you change them easily in one place

later:

<?xml version="1.0" encoding="utf-8"?>

<resources>

<color name="mycolor">#7fff00ff</color>

</resources>

You can reference colors by name in other XML �les, as we did in Chap-

ter 3, or you can use them in Java code like this:

color = getResources().getColor(R.color.mycolor);

The getResources( ) method returns the ResourceManager class for the

current activity, and getColor( ) asks the manager to look up a color

given a resource ID.

Paint

One of the Android native graphics library’s most important classes is

the Paint class. It holds the style, color, and other information needed

to draw any graphics including bitmaps, text, and geometric shapes.

Normally when you paint something on the screen, you want to draw it

in a solid color. You set that color with the Paint.setColor( ) method.
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For example:

cPaint.setColor(Color.LTGRAY);

This uses the prede�ned color value for light gray.

Canvas

The Canvas class represents a surface on which you draw. Initially can-

vases start off devoid of any content, like blank transparencies for an

overhead projector. Methods on the Canvas class let you draw lines,

rectangles, circles, or other arbitrary graphics on the surface.

In Android, the display screen is taken up by an Activity, which hosts a

View, which in turn hosts a Canvas. You get an opportunity to draw on

that canvas by overriding the View.onDraw( ) method. The only parameter

to onDraw( ) is a canvas on which you can draw.

Here’s an example activity called Graphics, which contains a view called

GraphicsView:

public class Graphics extends Activity {

@Override

public void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);

setContentView(new GraphicsView(this));

}

static public class GraphicsView extends View {

public GraphicsView(Context context) {

super(context);

}

@Override

protected void onDraw(Canvas canvas) {

// Drawing commands go here

}

}

We’re going to put some drawing commands into the onDraw( ) method

in the next section.

Path

The Path class holds a set of vector-drawing commands such as lines,

rectangles, and curves. Here’s an example that de�nes a circular path:

circle = new Path();

circle.addCircle(150, 150, 100, Direction.CW);

Report erratum

this copy is (P1.1 printing, May 26, 2008)
Prepared exclusively for Antonio Pardo

http://books.pragprog.com/titles/eband/errata/add?pdf_page=73


LEARNING THE BASICS 74

Figure 4.1: Drawing text around a circle

This de�nes a circle at position x=150, y=150, with a radius of 100

pixels. Now that we’ve de�ned the path, let’s use it to draw the circle’s

outline plus some text around the inside:

private static final String QUOTE = "Now is the time for all " +

"good men to come to the aid of their country.";

canvas.drawPath(circle, cPaint);

canvas.drawTextOnPath(QUOTE, circle, 0, 20, tPaint);

You can see the result in Figure 4.1. Since the circle was drawn in the

clockwise direction (Direction.CW), the text is also drawn that way.

If you want to get really fancy, Android provides a number of PathEffect

classes that let you do things such as apply a random permutation to a

path, cause all the line segments along a path to be smoothed out with

curves or broken up into segments, and create other effects.

Drawable

In Android, a Drawable class is used for a visual element like a bitmap or

solid color that is intended for display only. You can combine drawables
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with other graphics, or you can use them in user interface widgets (for

example, as the background for a button or view).

Drawables can take a variety of forms:

� Bitmap: A PNG or JPEG image.

� NinePatch: A stretchable PNG image, so named because originally

it divided the image into nine sections. These are used for the

background of resizable bitmap buttons.

� Shape: Vector-drawing commands, based on Path. This is sort of a

poor man’s SVG.

� Layers: A container for child drawables that draw on top of each

other in a certain z-order.

� States: A container that shows one of its child drawables based on

its state (a bit mask). One use is to set various selection and focus

states for buttons.

� Levels: A container that shows only one of its child drawables

based on its level (a range of integers). This could be used for a

battery or signal strength gauge.

� Scale: A container for one child drawable that modi�es its size

based on the current level. One use might be a zoomable picture

viewer.

Drawables are almost always de�ned in XML. Here’s a common exam-

ple where a drawable is de�ned to be a gradient from one color to

another (in this case, white to gray). The angle speci�es the direction of

the gradient (270 degrees means top to bottom). This will be used for

the background of a view:

<?xml version="1.0" encoding="utf-8"?>

<shape xmlns:android="http://schemas.android.com/apk/res/android">

<gradient

android:startColor="#FFFFFF"

android:endColor="#808080"

android:angle="270" />

</shape>

To use it, we could either refer to it in XML with the android:background=

attribute or call the Canvas.setBackgroundResource( ) method in the view’s

onCreate( ) method like this:

setBackgroundResource(R.drawable.background);

This gives our GraphicsView example a nice gradient background, as

shown in Figure 4.2, on the next page.

Report erratum

this copy is (P1.1 printing, May 26, 2008)
Prepared exclusively for Antonio Pardo

http://books.pragprog.com/titles/eband/errata/add?pdf_page=75


Prepared exclusively for Antonio Pardo


	Contents
	Acknowledgments
	FLAGCOLOR Changes (Cupcake Updates)
	FLAGCOLOR P1.1---May 26

	Preface
	What Makes Android Special?
	Who Should Read This Book?
	What's in This Book?
	FLAGCOLOR What's New for Cupcake?
	Online Resources
	Fast-Forward >>

	Introducing Android
	Quick Start
	Installing the Tools
	Creating Your First Program
	Running on the Emulator
	Running on a Real Phone
	Fast-Forward >>

	Key Concepts
	The Big Picture
	It's Alive!
	Building Blocks
	Using Resources
	Safe and Secure
	Fast-Forward >>


	Android Basics
	Designing the User Interface
	Introducing the Sudoku Example
	Designing by Declaration
	Creating the Opening Screen
	Using Alternate Resources
	Implementing an About Box
	Applying a Theme
	Adding a Menu
	Adding Settings
	Starting a New Game
	Debugging with Log Messages
	Debugging with the Debugger
	Exiting the Game
	Fast-Forward >>

	Exploring 2D Graphics
	Learning the Basics
	Adding Graphics to Sudoku
	Handling Input
	The Rest of the Story
	Making More Improvements
	Fast-Forward >>

	Multimedia
	Playing Audio
	Playing Video
	Adding Sounds to Sudoku
	Fast-Forward >>

	Storing Local Data
	Adding Options to Sudoku
	Continuing an Old Game
	Remembering the Current Position
	Accessing the Internal File System
	Accessing SD Cards
	Fast-Forward >>


	Beyond the Basics
	The Connected World
	Browsing by Intent
	Web with a View
	From JavaScript to Java and Back
	Using Web Services
	Fast-Forward >>

	Locating and Sensing
	Location, Location, Location
	Set Sensors to Maximum
	Bird's-Eye View
	Fast-Forward >>

	Putting SQL to Work
	Introducing SQLite
	SQL 101
	Hello, Database
	Data Binding
	Using a ContentProvider
	Implementing a ContentProvider
	Fast-Forward >>

	3D Graphics in OpenGL
	Understanding 3D Graphics
	Introducing OpenGL
	Building an OpenGL Program
	Managing Threads
	Building a Model
	Lights, Camera, ...
	Action!
	Applying Texture
	Peekaboo
	Fast-Forward >>


	Appendixes
	Java vs. the Android Language and APIs
	Language Subset
	Standard Library Subset
	Third-Party Libraries

	Creating a Widget
	Publishing to the Android Market
	Bibliography

	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W


